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RZ/V2L, RZ/V2H, RZ/V2N 
Getting Started with Flexible Software Package 
Introduction  
This manual describes how to use the Renesas Flexible Software Package (FSP) for writing applications for 
the RZ microprocessor series. 

 
Target Device 
RZ/V2L, RZ/V2H, RZ/V2N 
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1. Introduction  
1.1 Overview 
This application note describes how to use the Renesas Flexible Software Package (FSP) running on the 
Cortex®-M33 (hereinafter referred to as CM33) and Cortex®-R8(*)(hereinafter referred to as CR8) 
incorporated on RZ/V2L, RZ/V2H, and RZ/V2N. 
(*: CR8 is for RZ/V2H only.) 

 

1.2 Introduction to FSP 
1.2.1 Purpose 
The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide easy-
to-use, scalable, high-quality software for embedded system design. The primary goal is to provide 
lightweight, efficient drivers that meet common use cases in embedded systems. 

 

1.2.2 e² studio IDE 
FSP provides a host of efficiency-enhancing tools for developing projects targeting the Renesas RZ series of 
MPU devices. The e² studio IDE provides a familiar development cockpit from which the key steps of project 
creation, module selection and configuration, code development, code generation, and debugging are all 
managed. 

 

1.3 Limitations 
1.3.1 Peripherals and Pins Assignment 
RZ/V2L and RZ/V2N have a multi-core configuration of Cortex-A55 (hereinafter referred to as CA55) and 
CM33. Also, RZ/V2H has a multi-core configuration of CA55, CM33 and CR8. It is possible to use each 
peripheral and GPIO from each core. This package provides drivers for each peripheral for CM33 and CR8, 
but each driver can operate on the assumption that it is not used in CA55. 

 

1.3.2 RAM Initialization 
Initialization of DDR SDRAM is always carried out in the CA55 bootstrap regardless of the selection of the 
boot CPU; meanwhile, internal SRAM is initialized in the bootstrap of the boot CPU.  
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2. Starting Development Introduction 
2.1 e² studio Setup 
2.1.1 What is e² studio? 
Renesas e² studio is a development tool encompassing code development, build, and debug. e² studio is 
based on the open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT).  

When developing for RZ MPUs, e² studio hosts the Renesas Flexible Software Package (FSP). FSP 
provides a wide range of time saving tools to simplify the selection, configuration, and management of 
modules and threads, to easily implement complex applications.  

 

2.1.2 e² studio Prerequisites 
2.1.2.1 Obtaining an RZ MPU Kit 
To develop applications with RZ FSP, start with each Evaluation Board Kit. 
The start-up guide of the RZ/V2L Evaluation Board Kit is available at the RZ/V2L SMARC EVK Start-up 
Guide. Also, Getting Started of RZ/V2H Evaluation Board Kit is available at RZ/V2H EVK Getting Started. 

 

2.1.2.2 PC Requirements 
The following are the minimum PC requirements to use e² studio: 

• Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX 
• Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred) 
• Minimum 250 GB hard disk 

 

2.1.2.3 Licensing 
FSP licensing includes full source code, limited to Renesas hardware only. 

 
2.1.3 e² studio installation for Windows PC 
This chapter describes how to install the e² studio IDE on a Windows PC. 

 

2.1.3.1 Download 
The latest e² studio IDE installer package can be downloaded from Renesas website for free. Please check 
the detailed information from: https://www.renesas.com/e2studio. Note that users have to login to the 
Renesas account (in MyRenesas page) for the software download.  

 

  

https://community.renesas.com/cfs-file/__key/communityserver-discussions-components-files/420/r01us0556ej0102_2D00_rz_2D00_g_2800_Board_5F00_StartUp_5F00_Guide_5F00_smarcEVK_2900_-_2800_2_2900_.pdf
https://community.renesas.com/cfs-file/__key/communityserver-discussions-components-files/420/r01us0556ej0102_2D00_rz_2D00_g_2800_Board_5F00_StartUp_5F00_Guide_5F00_smarcEVK_2900_-_2800_2_2900_.pdf
https://renesas-rz.github.io/rzv_ai_sdk/3.00/getting_started.html
https://www.renesas.com/e2studio
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2.1.3.2 Installation of e² studio IDE 
1. Double-click on the e² studio installer to invoke the e² studio installation wizard page. First, you need to 

select the Install Type. In this material, it is expected that Custom Install will be selected. Then, click [Next 
>] to continue.  

 
Note: If e² studio was installed in your PC, the option to modify, remove the existing version, or install  

the e² studio to a different location will be displayed 

 

Figure 1.   e² studio installation wizard 
 

Note: If you are using a multi-user environment, you may receive a prompt to confirm whether you want to 
install it for the current user only or for all users. 

 

Figure 2.   e² studio installation wizard 
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2. Welcome page 
Users can change the install folder by clicking [Change…]. Click [Next] to continue. 

 

Note 1: If you would like to have multiple versions of e² studio, please specify a new folder here.  
Note 2: Multi-byte characters cannot be used for the e² studio installation folder name. 

 

Figure 3.   Installation of e² studio – Welcome page 
3. Device Families 

Select Device Families to install. Click the [Next] button to continue. 
 

 

Figure 4.   Installation of e² studio – Device Families 
 



RZ/V2L, RZ/V2H, RZ/V2N Getting Started with Flexible Software Package 

R01AN6240EJ0400  Rev.4.00  Page 8 of 70 
Feb.13.26  

4. Extra Features 
Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support…) to be installed. For 
non-English language users, please select Language packs at this step if needed.  
Click the [Next] button to continue. 

 

 

Figure 5.   Installation of e² studio – Extra Features 
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5. Customize Features 
Select the components to install and click the [Next] button to continue. Be sure that Renesas FSP Smart 
Configurator Core and Renesas FSP Smart Configurator ARM are selected. 

 

Figure 6.   Installation of e² studio – Features 
 
6. Additional Software 

Select additional software (i.e., compilers, utilities, QE…) to be installed. Be sure to select the following 
item and click [Next] to continue. 
 
GNU ARM Embedded 13.3-Rel1 

 

 

Figure 7.   Installation of e² studio – Additional Software 
 

For more details on the installation of Additional Software, please see section 2.1.3.3. 
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7. License Agreement 
Read and accept the software license agreement. Click the [Next] button. Please note that the user must 
accept the license agreement for the installation to continue. 

 

 

Figure 8.   Installation of e² studio – Licenses 

 
8. Shortcuts 

Select the shortcut name for the Start menu and click the [Next] button to continue. 
 
Note: If e² studio was installed in another location, it is recommended to rename to distinguish from the 

other e² studio(s). 

 

Figure 9.   Installation of e² studio – Shortcuts 
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9. Summary 
The components list to be installed is shown. Please confirm the contents and click the [Install] button to 
install the Renesas e² studio IDE. 

 

 

Figure 10.   Installation of e² studio – Summary 

 
10. Installing... 

The installation is performed. Depending on the selected items of additional software, new dialog prompts 
may appear during the installation process. Please see the chapter 2.1.3.3 for more detailed information. 

 
11. Results 

Click the OK button to complete the installation.  
 

 

Figure 11.   Summary Page 
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2.1.3.3 Installation of Additional Software 
As mentioned in section 2.1.3.2, the additional software listed below is essential for RZ FSP.  

GNU ARM Embedded 13.3-Rel1. 
 
In this section, the detailed procedure for installing this tool. 

 
• GNU ARM Embedded Toolchain 13.3-Rel1 

If it was selected in the Additional Software pane of e² studio, you will see the installation wizard for the 
GNU ARM Embedded Toolchain during the installation process. 

 

 

Figure 12.   Installation of GNU ARM Embedded Toolchain 
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2.1.4 e² studio installation for Linux PC 
This chapter describes how to install the e² studio IDE on a Linux PC. 

 

2.1.4.1 Download 
The following files are required to download before installation. 

SEGGER J-Link driver 
Please download the driver V8.60 or later from:  
https://www.segger.com/downloads/jlink 
 
e² studio IDE installer 
The e2 studio IDE installer package can be downloaded from the Renesas website for free. Please check 
the detailed information from: https://www.renesas.com/e2studio. 
 

2.1.4.2 Installation 
This section describes the procedure for each software installation.  

Filename, version number, and the file path are provided for example purposes only. 

• SEGGER J-Link driver 
1. Open a terminal window and enter the commands below. 

sudo dpkg -i JLink_Linux_V860_x86_64.deb 
 
(If the previous install fails with unmet dependencies, retry it as follows) 
sudo apt-get -f install 
sudo dpkg -i JLink_Linux_V860_x86_64.deb 

 
 
• e² studio IDE 

1. Run the e² studio IDE Installer. (Before running the installer, check the execution permission of the 
installer.) 
./e2studio_installer-yyyy-mm_linux_host.run 

2. Welcome page 
Users need to select Install Type as shown below. In this material, it is expected that Custom Install is 
selected. Then, click [Next >] to continue. 

 

 

Figure 15.   Installation of e² studio – Welcome page 

https://www.renesas.com/e2studio
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3. Welcome page (Cont’d) 

Users can change the install folder by clicking [Change…].  
Click [Next] to continue. 

 
Note 1: If you would like to have multiple versions of e² studio, please specify a new folder here.  
Note 2: Multi-byte characters cannot be used for the e² studio installation folder name. 
 

 

Figure 16.   Installation of e² studio – Welcome page 
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4. Device Families 
Select Device Families to install. Click the [Next] button to continue. 

 

 

Figure 17.   Installation of e² studio – Device Families 
 

5. Extra Features  
Select Extra Features (i.e., Language packs, SVN & Git support, RTOS support…) to be installed. For 
non-English language users, please select Language packs at this step if needed.  
Click the [Next] button to continue. 

 

 

Figure 18.   Installation of e² studio – Extra Features 
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6. Customize Features  
Select the components to install and click the [Next] button to continue. 

 

 

Figure 19.   Installation of e² studio – Features 
 

7. Additional Software 
Select additional software (i.e., compilers, utilities, QE…) to be installed. Be sure to select the “GNU 
ARM Embedded 13.3-Rel1” and click [Next >] to continue. 

 

 

Figure 20.   Installation of e² studio – Additional Software 
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8. License Agreement  
Read and accept the software license agreement. Click the [Next] button. Please note that users must 
accept the license agreement for the installation to continue. 

 

Figure 21.   Installation of e² studio – Licenses 

9. Shortcuts  
Select the shortcut name for the Start menu and click the [Next] button to continue. 

 
Note: If e² studio was installed in another location, it is recommended to rename to distinguish from the other 

e² studio(s). 
 

 

Figure 22.   Installation of e² studio – Shortcuts 
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10. Summary  
The components list to be installed is shown. Please confirm the contents and click the [Install] button 
to install the Renesas e² studio IDE. 

 

 

Figure 23.   Installation of e² studio – Summary 

 
11. Installing... 

The installation is performed. Depending on the selected items of additional software, new dialog 
prompts may appear during the installation process. 

 
12. Results  

Click the OK button to complete the installation.  
 

 

Figure 24.   Summary Page 
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2.2 FSP setup 
2.2.1 Installation of FSP using Package Installer 
Package Installer RZ_FSP_Packs_v4.0.0.exe is showcased here. This section describes the procedure for 
installation. Note that it’s for the Windows Host PC only. 

1. Quit e2 studio. 
2. Invoke RZ_FSP_Packs_v4.0.0.exe. 
3. Click [Next >] to start the installation. 
 

 

Figure 25.   FSP Package Installer 
 
4. See the license term and click [I Agree] if it’s acceptable. 
 

 

Figure 26.   FSP License Term 

 
  

https://github.com/renesas/rz-fsp
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5. Specify e2 studio installation folder (e.g., C:\Renesas\e2studio) and click [Install]. 
 

  

Figure 27.   Browse to the folder where e2 studio is installed 

 
6. Click [Finish] to complete the installation. 
 

  

Figure 28.   Completion of FSP Installation 
 

If the box Open up documentation for this release is checked at that time, FSP documentation for the 
installed version of FSP should be opened. 
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2.2.2 Installation of FSP Pack using Package Zip file 
No package installer is available for the Linux Host PC. Thus, you need to install FSP with the zip file 
RZ_FSP_Packs_v4.0.0.zip. This section describes the procedure for installation. 

 
1. Download RZ_FSP_Packs_v4.0.0.zip from here. 
2. Extract the zip file to e2 studio installation directory. If it’s successfully extracted, rz_fsp/packs should be 

placed at <e2 studio installation directory>/Internal/projectgen. 
 

 

Figure 29.   FSP Packs on the e2 studio installation directory 

 
3. At the 1st invocation of e2 studio after the extraction, FSP should be automatically installed. 
4. You can check if the installation is successful by following the procedure below: 
Click Help > CMSIS Packs Management > Renesas RZ 

 

Figure 30.   CMSIS Packs Management (1) 

 
• If FSP is successfully installed, 4.0.0 should be listed under FSP as shown below: 

 

https://github.com/renesas/rz-fsp
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Figure 31.   CMSIS Packs Management (2) 

3. Set up an SMARC EVK 
3.1 Set up an RZ/V2L SMARC EVK 
Below is an example of a typical system configuration. 

 

Figure 32.   System Configuration Example – RZ/V2L SMARC EVK 
 

3.1.1 Supported Emulator 
• SEGGER J-Link 
 
For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER – the Embedded Experts. 

 

 

https://www.segger.com/products/debug-probes/j-link/
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3.1.2 Board Setup 
3.1.2.1  Boot MODE 
To set the board to Boot mode 3(QSPI Boot(1.8V) Mode), set the SW11 as below. 

 

Figure 33.   Boot MODE 
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3.1.2.2 JTAG connection 
When connecting JTAG, you must set the DIP SW1 settings as follows: 

 

Figure 34.   JTAG connection 
 

Please note that RZ/V2L SMARC EVK has a CoreSight 10 connector and therefore, the following adapter is 
needed to connect to Segger J-Link. 

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/ 
 

3.1.2.3 Debug Serial (console output) 
Debug serial uses CN14. The baud rate is 115200bps. 

 

Figure 35.   Debug Serial (console output) 
 

  

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/
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3.1.2.4 Power Supply 
Here are the power supply-related goods to be used in Renesas’ development. Please prepare for the 
equivalent ones for your development. 

• USB Type-C cable CB-CD23BK (manufactured by Aukey) 
• USB PD Charger Anker PowerPort III 65W Pod (manufactured by Anker) 

 

Figure 36.   Power Supply 
 

Connect the USB-PD Power Charger to the USB Type-C Connector. Then LED1(VBUS PWR On) and LED3 
(Module PWR On) light up. Press SW9 to turn on the power. Then LED4(Carrier PWR On) lights up. 

Note: When you turn on the power, press and hold the power button for 1 second. 
When you turn off the power, press and hold the power button for 2 seconds 

 

Figure 37.   LED Status after Turning on EVK 
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3.1.2.5 How to check the operation of the board 
First, check the board for problems. There are two ways to do this. Please check with either.  

 

BOOT MODE: QSPI Boot(1.8V) Mode 

If u-boot is written to the serial flash, when the power is turned on, the following will be output to the console 
(CN14). 

 

 

BOOT MODE: SCIF Download Mode 

When the power is turned on, the following will be output to the console (CN14). 
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3.2 Set up an RZ/V2H EVK 
Below is an example of a typical system configuration. 

 

Figure 38.   System Configuration Example – RZ/V2H EVK 
 

3.2.1 Supported Emulator 
• SEGGER J-Link 
 
For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER – the Embedded Experts. 

 

3.2.2 Board Setup 
3.2.2.1  Boot MODE 
Set the boot mode using the DSW1 shown in the figure below. 

 

Figure 39.   Boot MODE 
  

RZ/V2H  EVK 

DSW1 

https://www.segger.com/products/debug-probes/j-link/
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Select the boot mode with the following settings. 

Switch No. Function 
1 Select the cold boot CPU 

   OFF: CM33 / ON: CA55 
2 Input the CA55 frequency at the CA55 cold boot. 

[SW2 : SW3]  = [OFF : OFF]  :  1.6GHz 
  = [OFF : ON]  :  1.7GHz [default] 
  = [ON  :  OFF]  :  1.1GHz 
  = [ON  :  ON]  :  1.5GHz 

3 

4 Input the boot mode select signal. 
[SW4 : SW5]  = [OFF : OFF]  :  xSPI 
  = [OFF : ON]  :  SCIF 
  = [ON  :  OFF]  :  SD 
  = [ON  :  ON]  :  eMMC 

5 

6 OFF: SSCG OFF / ON: SSCG ON 
7 OFF: Normal mode / ON: Debug mode 
8 Fix OFF 

 
3.2.2.2 JTAG connection 
When connecting to JTAG, you must set the DSW1 Switch No.7 settings to ON. 

 

Figure 40.   JTAG connection 
 

Please note that RZ/V2H EVK has a CoreSight 10 connector and therefore, the following adapter is needed 
to connect to Segger J-Link. 

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/ 
 

  

connect DSW1 

CN1 

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/
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3.2.2.3 Debug Serial (console output) 
Debug serial uses CN12. The baud rate is 115200bps. 

 

Figure 41.   Debug Serial (console output) 
 
3.2.2.4 Power Supply 
Here are the power supply-related goods to be used in Renesas’ development. Please prepare for the 
equivalent ones for your development. 

• USB PD Charger MAGCUBE PD 100W (AOC-C005) (manufactured by AOHI) 
• USB Type-C cable included with MAGCUBE PD 100W (AOC-C005) (manufactured by AOHI) 

 

Check that the power slide switches SW2 and SW3 are turned OFF. 

                       

Figure 42.   Power Supply 
 

  

connect 

CN12 

SW3 

SW2 
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Connect the USB-PD Power Charger to CN13. 

Turn the SW3 ON, then LD2 and LD7 light up. 

Turn the SW2 ON, then LD1, LD3, and LD4 light up. 

 

Figure 43.   Power Supply 
 
  

CN13 
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3.3 Set up an RZ/V2N EVK 
Below is an example of a typical system configuration. 

 

Figure 44.   System Configuration Example – RZ/V2N EVK 
 

3.3.1 Supported Emulator 
• SEGGER J-Link 
 
For details on SEGGER J-Link, please see J-Link Debug Probes by SEGGER – the Embedded Experts. 

 

3.3.2 Board Setup 
3.3.2.1  Boot MODE 
Set the boot mode using the DSW1 shown in the figure below. 

 

Figure 45.   Boot MODE 
  

RZ/V2N  EVK 

https://www.segger.com/products/debug-probes/j-link/
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Select the boot mode with the following settings. 

Switch No. Function 
1 Select the cold boot CPU 

   OFF: CM33 / ON: CA55 
2 Input the CA55 frequency at the CA55 cold boot. 

[SW2 : SW3]  = [OFF : OFF]  :  1.6GHz 
  = [OFF : ON]  :  1.7GHz [default] 
  = [ON  :  OFF]  :  1.1GHz 
  = [ON  :  ON]  :  1.5GHz 

3 

4 Input the boot mode select signal. 
[SW4 : SW5]  = [OFF : OFF]  :  xSPI 
  = [OFF : ON]  :  SCIF 
  = [ON  :  OFF]  :  SD 
  = [ON  :  ON]  :  eMMC 

5 

6 OFF: SSCG OFF / ON: SSCG ON 
7 OFF: Normal mode / ON: Debug mode 
8 Fix OFF 

 
3.3.2.2 JTAG connection 
When connecting to JTAG, you must set the DSW1 Switch No.7 settings as ON. 

 

Figure 46.   JTAG connection 
 

Please note that RZ/V2N EVK has a CoreSight 10 connector and therefore, the following adapter is needed 
to connect to Segger J-Link. 

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/ 
 

  

connect DSW1 

CN1 

https://www.segger.com/products/debug-probes/j-link/accessories/adapters/9-pin-cortex-m-adapter/
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3.3.2.3 Debug Serial (console output) 
Debug serial uses CN12. The baud rate is 115200bps. 

 

Figure 47.   Debug Serial(console output) 
 
3.3.2.4 Power Supply 
Here are the power supply-related goods to be used in Renesas’ development. Please prepare for the 
equivalent ones for your development. 

• USB PD Charger MAGCUBE PD 100W (AOC-C005) (manufactured by AOHI) 
• USB Type-C cable included with MAGCUBE PD 100W (AOC-C005) (manufactured by AOHI) 

 

Check that the power slide switches SW2 and SW3 are turned OFF. 

                       

Figure 48.   Power Supply 
 

  

connect 

CN12 

SW3 

SW2 
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Connect the USB-PD Power Charger to CN13. 

Turn the SW3 ON, then turn the SW2 ON. 

 

Figure 49.   Power Supply 
 
 
 
  

CN13 
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4. Tutorial: Your First RZ MPU Project - Blinky 
4.1 Tutorial Blinky 
The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of 
creating a simple application using e² studio and running that application on an RZ MPU board. 

 

4.2 What Does Blinky Do? 
The application used in this tutorial is Blinky, traditionally the first program run in a new embedded 
development environment. 

Blinky is the "Hello World" of microprocessors. If the LED blinks, you know that: 

• The toolchain is set up correctly and builds a working executable image for your chip. 
• The debugger has been installed with working drivers and is properly connected to the board. 
• The board is powered up, and its jumper and switch settings are probably correct. 
• The microprocessor is alive, the clocks are running, and the memory is initialized. 
• Timer (GTM) interrupt is intentionally fired, and GPIO is properly controlled. 

 
Note: RZ/V2H SMARC EVK has an on-board LED but RZ/V2L SRMAC EVK board does not have any LED. 

Thus, the Blinky sample application for RZ/V2L SRMAC EVK is designed to use the Pmod module 
described below alternatively:  
• Pmod LED (Four High-brightness LEDs): https://reference.digilentinc.com/pmod/pmodled/start 

 
This module is not included on the RZ/V2L SRMAC EVK board, and so, please prepare it beforehand. 

 

Figure 50.   Connection Pmod LED module (410-076)  
In the case of RZ/V2H EVK and RZ/V2N EVK, the on-board LED is placed as shown below. 

   
 

Figure 51.   On-board LED of RZ/V2H EVK and RZ/V2N EVK 
 

On-board LED 

Pmod0 

RZ/V2N EVK RZ/V2H EVK 

https://reference.digilentinc.com/pmod/pmodled/start
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4.3 Create a New Project for Blinky 
The creation and configuration of an RZ C/C++ FSP Project is the first step in the creation of an application.  

The base RZ pack includes a pre-written Blinky example application. 

Follow these steps to create an RZ MPU project: 

1. In e² studio, click File > New > C/C++ Project. 

 

Figure 52.   New C/C++ Project 
2. Select [Renesas RZ] > [Renesas RZ C/C++ FSP Project] and Click Next. 

 

Figure 53.   Renesas RZ C/C++ FSP Project 
 

3. Assign a name to this new project. Blinky is a good name to use for this tutorial. 
4. Click Next. The Project Configuration window shows your selection. 

 

Figure 54.   e² studio Project Configuration window (part 1) 
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5. Select the board support package by selecting the name of your board from the Device Selection drop-
down list. Select GNU ARM Embedded in Toolchains and version is 13.3.1 arm-13-24, and click Next. 

 

Figure 55.   e² studio Project Configuration window (part 2) 
6. Select None for the primary processor core and click Next. 

 

Figure 56.   e² studio Project Configuration window (part 3) 
7. Select the build artifact and RTOS. Be sure that on the current version, Secure should always be 

chosen at the Sub-core start state. Otherwise, the created project can’t be built successfully. 

 

Figure 57.   e² studio Project Configuration window (part 4) 
 



RZ/V2L, RZ/V2H, RZ/V2N Getting Started with Flexible Software Package 

R01AN6240EJ0400  Rev.4.00  Page 38 of 70 
Feb.13.26  

8. Select the Blinky template for your board and click Finish. 

         
 
 

Figure 58.   e² studio Project Configuration window (part 5) 
 

Once the project has been created, the name of the project will show up in the Project Explorer window 
of e² studio. Now, click the Generate Project Content button in the top right corner of the Project 
Configuration window to generate your board-specific files. 

 

Figure 59.   e² studio Project Configuration tab 
 
• Your new project is now created, configured, and ready to build. 
  

Templates for RZ/V2L Templates for RZ/V2H and RZ/V2N 



RZ/V2L, RZ/V2H, RZ/V2N Getting Started with Flexible Software Package 

R01AN6240EJ0400  Rev.4.00  Page 39 of 70 
Feb.13.26  

4.3.1 Details about the Blinky Configuration 
The Generate Project Content button creates configuration header files, copies source files from templates, 
and generally configures the project based on the state of the Project Configuration screen. 

For example, if you check a box next to a module in the Components tab and click the Generate Project 
Content button, all the files necessary for the inclusion of that module into the project will be copied or 
created. If that same check box is then unchecked, those files will be deleted. 

 
4.3.2 Configuring the Blinky Clocks 
By selecting the Blinky template, the clocks are configured by e² studio for the Blinky application. The clock 
configuration tab (see 5.2.3 Configuring Clocks) shows the Blinky clock configuration. The Blinky clock 
configuration is stored in the BSP clock configuration file. 

 
4.3.3 Configuring the Blinky Pins 
By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e² studio for the 
Blinky application. The pin configuration tab shows the pin configuration for the Blinky application (see 
5.2.4.Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file. 

 
4.3.4 Configuring the Parameters for Blinky Components 
The Blinky project automatically selects the following HAL components in the Components tab: 
 

• r_gtm 
• r_ioport 

 

To see the configuration parameters for any of the components, check the Properties tab in the HAL window 
for the respective driver (see 5.2.8.Adding and Configuring HAL Drivers). 

 
4.3.5 Where is main()? 
The main function is located in < project >/rz_gen/main.c. It is one of the files that are generated during the 
project creation stage and only contains a call to hal_entry(). For more information on generated files, see 
Adding and Configuring HAL Drivers. 

 
4.3.6 Blinky Example Code 
The blinky application is stored in the hal_entry.c file. This file is generated by e² studio when you select the 
Blinky Project template and is located in the project's src/ folder. 

The application performs the following steps: 
 
1. Get the LED information for the selected board from the bsp_leds_t structure. 
2. Set the configuration of Timer (GTM) and the callback function that is called when interrupt is fired. 
3. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board. 
4. Toggle the LEDs by writing to the GPIO pin with “R_BSP_PinWrite((bsp_io_port_pin_t) pin, pin_level)” in 

the callback function of GTM that is called with the specified interval. 
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4.4 Build the Blinky Project 
Highlight the new project in the Project Explorer window by clicking on it and building it. 

There are three ways to build a project: 
 
1. Click on Project in the menu bar and select Build Project. 
2. Click on the hammer icon. 
3. Right-click on the project and select Build Project. 

 

Figure 60.   e² studio Project Explorer window 
 

Once the build is complete, a message is displayed in the build Console window that displays the final 
image file name and section sizes in that image. 

 

 

Figure 61.   e² studio Project Build console 
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4.5 Debug the Blinky Project 
4.5.1 Debug prerequisites 
To debug the project on a board, you need 
 

• The board to be connected to e² studio 
• The debugger needs to be configured to talk to the board 
• The application is to be programmed for the microprocessor 

 
Applications run from the internal ram or external ram of your microprocessor. To run or debug the 
application, the application must first be programmed to ram by a JTAG debugger. The SMARC EVK board 
has a JTAG header and requires an external JTAG debugger to connect to the header. 

 
4.5.2 Debug steps 
To debug the Blinky application, follow these steps: 
1. Configure the debugger for your project by clicking Run > Debugger Configurations ... 

 

Figure 62.   e² studio Debug icon 
or by selecting the drop-down menu next to the bug icon and selecting Debugger Configurations ... 

 

Figure 63.   e² studio Debugger Configurations selection option 
 
2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking the 

New icon in the top left corner of the window. Once selected, the Debug Configuration window displays 
the Debug configuration for your Blinky project. 
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Figure 64.   e² studio Debugger Configurations window with Blinky project (1) 
 
3. Select the debug configuration for the generated project and select the Debugger tab. 
4. Click Debug to begin debugging the application. 
5. Extracting RZ Debug. 
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4.5.3 Details about the Debug Process 
In debug mode, e² studio executes the following tasks: 

1. Downloading the application image to the microprocessor and programming the image to the internal 
and/or external memory. 

2. Setting a breakpoint at main(). 
3. Setting the stack pointer register to the stack. 
4. Loading the program counter register with the address of the reset vector. 
5. Displaying the startup code where the program counter points to. 

 

Figure 65.   e² studio Debugger memory window 
 
4.5.4 Run the Blinky Project 
While in Debug mode, click Run > Resume or click on the Play icon twice. 

 

Figure 66.   e² studio Debugger Play icon 
 

The LED (RZ/V2L SRMAC EVK: Pmod LED, RZ/V2H SRMAC EVK: On-board LED) should now be blinking. 
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5. FSP application launch with e² studio 
This section describes how to create a project and debug in a single-core environment. Please refer to the 
section 6 for the multi-core project creation and debugging in RZ/V2H. 

5.1 Create a Project 
5.1.1 What is a Project? 
In e² studio, all FSP applications are organized in RZ MPU projects. Setting up an RZ MPU project involves: 

1. Create a Project 
2. Configuring a Project 

 

These steps are described in detail in the next two sections. When you have existing projects already, after 
you launch e² studio and select a workspace, all projects previously saved in the selected workspace are 
loaded and displayed in the Project Explorer window. Each project has an associated configuration file 
named configuration.xml, which is located in the project's root directory. 

 

Figure 67.   e² studio Project Configuration file 
 

Double-click on the configuration.xml file to open the RZ MPU Project Editor. To edit the project 
configuration, make sure that the FSP Configuration perspective is selected in the upper right-hand corner 
of the e² studio window. Once selected, you can use the editor to view or modify the configuration settings 
associated with this project. 

 

Figure 68.   e² studio FSP Configuration Perspective 
Note: Whenever the RZ project configuration (that is, the configuration.xml file) is saved, a verbose RZ 

Project Report file (rz_cfg.txt) with all the project settings is generated. The format allows differences 
to be easily viewed using a text comparison tool. The generated file is located in the project root 
directory. 
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Figure 69.   RZ Project Report 

 
The RZ Project Editor has several tabs. The configuration steps and options for individual tabs are discussed 
in the following sections. 

Note: The tabs available in the RZ Project Editor depend on the e² studio version, and the layout may vary 
slightly, the functionality should be easy to follow. 

 

Figure 70.   RZ Project Editor tabs 

 
5.1.2 Creating a New Project 
For RZ MPU applications, generate a new project using the following steps: 

1. Click on File > New > C/C++ Project. 

 

Figure 71.   New RZ MPU Project 
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2. Then click on the Renesas RZ C/C++ FSP Project template for the type of project you are creating. 

 

Figure 72.   New Project Templates 
 
3. Select a project name and location. 

 

Figure 73.   RZ MPU Project Generator (Screen 1) 
4. Click Next. 
 
 
5.1.2.1 Selecting a Board and Toolchain 
In the Project Configuration window, select the hardware and software environment: 
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1. Select the FSP version. 
2. Select the Board for your application. You can select an existing RZ MPU Evaluation Kit or select a 

Custom User Board for any of the RZ MPU devices with your own BSP definition. 
3. Select the Device. The Device is automatically populated based on the Board selection. Only change 

the Device when using the Custom User Board for board selection. 
4.  Select the Core. You can select Core 6(CM33_0), Core 4(CR8_0) or Core 5(CR8_1) if you selected 

RZ/V2H for the Device. 
5. To add threads, select RTOS or No RTOS if an RTOS is not being used. 
6. The Toolchain selection defaults to GNU Arm Embedded. 
7. Select the Toolchain version. This should default to the installed toolchain version. 
8. Select the Debugger. The J-Link Arm Debugger is preselected. 
9. Click Next. 

 

Figure 74.   RZ MPU Project Generator (Screen 2-1) 
 
If Core 4(CR8_0) or Core 5(CR8_1) is selected in procedure 4, you need to select the preceding project. 
To select the preceding project when creating the Core 4(CR8_0) or Core 5(CR8_1) project, it is required to 
prepare Core 6(CM33_0) before Core 4(CR8_0) or Core 5(CR8_1) project creation.  
 

 

Figure 75.   RZ MPU Project Generator (Screen 2-2) 
 
 
5.1.2.2 Selecting a Project Template 
In the next window, select the build artifact, Sub-core start state, and RTOS. Be sure that you select 
Secure as the Sub-core start state in the current version. 
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Figure 76.   RZ MPU Project Generator (Screen 3)  
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In the next window, select a project template from the list of available templates. By default, this screen 
shows the templates that are included in your current RZ/V MPU Pack. Once you have selected the 
appropriate template, click Finish. 

Note: If you want to develop your own application, select the basic template for your board, Bare Metal - 
Minimal or FreeRTOS - Blinky. 

 

  
 

 
 

  
 
 

Figure 77.   RZ MPU Project Generator (Screen 4) 
 

  

RZ/V2L case 

RZ/V2H and RZ/V2N case 

OR 

OR 
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When the project is created, e² studio displays a summary of the current project configuration in the RZ MPU 
Project Editor. 

 

Figure 78.   RZ MPU Project Editor and available editor tabs 
 
At the bottom of the RZ MPU Project Editor view, you can find the tabs for configuring multiple aspects of 
your project: 

• With the Summary tab, you can see all the key characteristics of the project: board, device, 
toolchain, and more. 

• With the BSP tab, you can change board-specific parameters from the initial project selection. 
• With the Clocks tab, you can configure the MPU clock settings for your project. 
• With the Interrupts tab, you can add new user events/interrupts. 
• With the Event Links tab, you can configure events used by the Event Link Controller. 
• With the Stacks tab, you can add and configure FSP modules. For each module selected in this 

tab, the Properties window provides access to the configuration parameters and interrupt 
selections. 

• The Components tab provides an overview of the selected modules. Although you can also add 
drivers for specific FSP releases and application sample code here, this tab is normally only used 
for reference. 

 
The functions and use of each of the supported tabs is explained in detail in the next section. 
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5.1.3 Duplication of Resources 
In the case of the RZ/V2H Core 4(CR8_0) or Core 5(CR8_1) project, duplicate resources are indicated as a 
red character in the Stacks tab when using resources that are used in the linked Core 6(CM33_0) project. 
 
The following image is an example of both Core 6(CM33_0) and Core 4(CR8_0) projects using the same 
resource. The duplication of r_gtm is indicated in the Stacks tab. To avoid this duplication, please change 
the channel resource in Properties of r_gtm. 
 

 

Figure 79.   Duplication of resource between Core 6(CM33_0) and Core 4(CR8_0) projects 
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5.2 Configuring a Project 
Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ 
Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user 
code is executed is set by the configuration settings in the BSP tab. When you select a project template 
during project creation, e² studio configures default values that are appropriate for the associated board. You 
can change those default values as needed. The following sections detail the process of configuring each of 
the project elements for each of the associated tabs. 

 
5.2.1 Summary Tab 

 

Figure 80.   Configuration Summary tab 
The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It 
shows the target board, the device, the toolchain, and the FSP version. Additionally, it provides a list of all 
the selected software components and modules used by the project. This is a more convenient summary 
view when compared to the Components tab. 

 
5.2.2 Configuring the BSP 
The BSP tab shows the currently selected board (if any) and device. The Properties view is located in the 
lower left of the Project Configurations view, as shown below. 

Note: If the Properties view is not visible, click Window > Show View > Properties in the top menu bar. 

 

Figure 81.   Configuration BSP tab 
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The Properties view shows the configurable options available for the BSP. These can be changed as 
required. The BSP is the FSP layer above the MPU hardware. e² studio checks the entry fields to flag invalid 
entries. For example, only valid numeric values can be entered for the stack size.  

When you click the Generate Project Content button, the BSP configuration contents are written to 
rz_cfg/fsp_cfg/bsp/bsp_cfg.h This file is created if it does not already exist. 

Warning 
Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked. 

 
5.2.3 Configuring Clocks 
The Clocks tab presents a graphical view of the MPU's clock tree, and each HAL driver uses the settings for 
dedicated numerical calculation. For example, the scif_uart driver calculates the communication rate from the 
settings in the Clocks tab. Please note that the clock configuration is carried out on the main core (CA55) in 
advance when CM33 works as a sub-core. Thus, clocks configuration here must align with the settings on 
CA55. 

In the case of CM33 cold boot, BSP will configure each clock setting in the start-up process according to the 
content of the Clocks tab. 

 

Figure 82.   Configuration Clocks tab 
 

When you click the Generate Project Content button, the clock configuration contents are written to: 
rz_gen/bsp_clock_cfg.h  

This file will be created if it does not already exist. 

Warning: Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked. 
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5.2.4 Configuring Pins 
The pins tab provides a flexible configuration of the MPU’s pins. As many pins can provide multiple functions, 
they can be configured on a peripheral basis. For example, selecting a serial channel via the SCIF peripheral 
offers multiple options for the location of the receive and transmit pins for that module and channel. The 
location and function of the pins are shown in the FSP Visualization view. For more information on the 
function and color coding of the pins, please check the Legend in the FSP Visualization view. 

 

 

Figure 83.   Pin Configuration 

 
The pin configurator includes a built-in conflict checker. So, if the same pin is allocated to another peripheral 
or I/O function, the pin will be shown as red in the FSP Visualization view and with a white cross in a red 
square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. 

In the example shown below, port P70 is already used by the IRQ_IRQ0, and the attempt to connect to this 
pin to the GPT results in a dangling connection error. To fix this error, select another port from the pin drop-
down list or disable the IRQ_IRQ0. 

 

 

Figure 84.   e2 studio Pin Configurator 

 
When you click the Generate Project Content button, the pin configuration contents are written to: 
rz_gen\pin_data.c. This file will be created if it does not already exist. 

Warning: Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked. 
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In the case of versions earlier than RZ/V FSP v2.0.0, it does not support the Pins tab, and if the user would 
like to use the I/O port, the I/O Port setting should be applied to “src/pin_data.c” manually. For details on I/O 
Port setting, please refer to Setting GPIO with Flexible Software Package. 
 
5.2.5 Configuring Interrupts from the Stacks Tab 
You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority. 
Select the driver in the Stacks pane to view and edit its properties. 

 

Figure 85.   Configuring Interrupts in the Stacks tab 
 

 

Figure 86.   Add new stack Timer (GTM) 
 

  

https://www.renesas.com/node/1570166
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5.2.6 Creating Interrupts from the Interrupts Tab 
On the Interrupts tab, the interrupt of the driver selected in the Stacks tab is registered.  

 

Figure 87.   Configuring an interrupt in the Interrupt Tab 
And on the Interrupts tab, the user can add a peripheral interrupt created by the user.  
This can be done by adding a new event via the New User Event button. 
 
5.2.7 Viewing Event Links 
The Event Links tab can be used to view the Event Link Controller events. The events are sorted by 
peripheral to make it easy to find and verify them. 
 

 

Figure 88.    e2 studio Project configurator – Viewing Event Links 

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can be 
defined by clicking the relevant New User Event button. Once a consumer is linked to a producer, the link 
will appear in the Allocations section at the bottom. 
 

Note 1: When selecting an ELC event to receive for a module (or when manually defining an event link), only 
the events that are made available by the modules configured in the project will be shown. 

 
Note 2: On devices that do not have ELC, this tab is not available, and it is grayed out. 
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5.2.8 Adding and Configuring HAL Drivers 
For applications that run outside or without the RTOS, you can add additional HAL drivers to your application 
using the HAL/Common thread. To add drivers, follow these steps: 

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common 
Stacks. 

2. Click New Stack to see a drop-down list of HAL-level drivers available in the FSP. 
3. Select a driver from the menu New Stack > Driver. 

 

Figure 89.   e² studio Project configurator - Adding drivers 
4. Select the driver module in the HAL/Common Modules pane and configure the driver properties in the 

Properties view. 
 
e² studio adds the following files when you click the Generate Project Content button: 

• The selected driver module and its files to the rz/fsp directory 
• The main() function and configuration structures and header files for your application as shown in 

the table below. 
File Contents Overwritten by Generate 

Project Content? 
rz_gen/main.c Contains main() calling generated 

and user code. When called, the 
BSP has already initialized the 
MPU. 

Yes 

rz_gen/hal_data.c Configuration structures for HAL 
Driver only modules. 

Yes 

rz_gen/hal_data.h Header file for HAL driver only 
modules. 

Yes 

src/hal_entry.c User entry point for HAL Driver 
only code. Add your code here. 

No 

 
The configuration header files for all included modules are created or overwritten in this folder: rz_cfg/fsp_cfg 
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5.3 Reviewing and Adding Components 
The Components tab enables the individual modules required by the application to be included or excluded. 
Modules common to all RZ/V MPU projects are preselected. All modules that are necessary for the modules 
selected in the Stacks tab are included automatically. You can include or exclude additional modules by 
ticking the box next to the required component. 

 

Figure 90.   Components Tab 
 
Clicking the Generate Project Content button copies the .c and .h files for each selected component into 
the following folders: 

• rz/fsp/inc/api 
• rz/fsp/inc/instances 
• rz/fsp/src/bsp 
• rz/fsp/src/<Driver_Name> 

 
e² studio also creates configuration files in the rz_cfg/fsp_cfg folder with configuration options set in the 
Stacks tab. 
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5.4 Debugging the Project 
Once your project builds without errors, you can use the Debugger to download your application to the board 
and execute it. 

To debug an application, follow these steps: 

1. On the drop-down list next to the debug icon, select Debug Configurations. 

 

2. In the Debug Configurations view, click on your project listed as MyProject Debug. 

 

3. Secure and Non-secure Vector Addresses are configured in the Connection Settings tab of the 
Debugger tab. The settings in the image below are for setting the address of Secure and Non-secure 
Vector Offset (*) mapped in the Blinky project. Please note that these addresses vary in accordance with 
linker settings. 
(*: In the case of RZ/V2H and RZ/V2N projects, Non-secure Vector is empty since it is not used.) 

 

 

 
 

4. Connect the board to your PC via a standalone Segger J-Link debugger and click Debug. 
Note: For details on using J-Link and connecting the board to the PC, see 3.1.2.2.JTAG connection. 
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5.5 Modifying Toolchain Settings 
There are instances where it may be necessary to make changes to the toolchain being used (for example, 
to change the optimization level of the compiler or add a library to the linker). Such modifications can be 
made from within e² studio through the menu Project > Properties > Settings when the project is selected. 
The following screenshot shows the settings dialog for the GNU Arm toolchain. This dialog will look slightly 
different depending on the toolchain being used. 

 

Figure 91.   e² studio Project toolchain settings 
 

The scope for the settings is project scope, which means that the settings are valid only for the project being 
modified. 

The settings for the linker, which control the location of the various memory sections, are contained in a 
script file specific to the device being used. This script file is included in the project when it is created and is 
found in the script folder (for example, /script/fsp.ld). 
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5.6 Importing an Existing Project into e² studio 
1. Start by opening e² studio. 
2. Open an existing Workspace to import the project and skip to step d. If the workspace does not exist, 

proceed with the following steps: 
 

a. At the end of the e² studio startup, you will see the Workspace Launcher Dialog box as shown in 
the following figure. 

 

Figure 92.    Workspace Launcher dialog 

b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the following figure. 
e² studio creates a new workspace with this name. 

 

Figure 93.   Workspace Launcher dialog - Select Workspace 

c. Click Launch. 
d. When the workspace is opened, you may see the Welcome Window. Click on the Workbench 

arrow button to proceed past the Welcome Screen, as seen in the following figure. 

 

Figure 94.    Workbench arrow button 
3. You are now in the workspace that you want to import the project into. Click the File menu in the menu 

bar, as shown in the following figure. 

 

Figure 95.    Menu and toolbar 
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4 Click Import on the File menu or “Import project” on Project Explorer, as shown in the following figure. 

 

Figure 96.   File drop-down menu 
 

5. In the Import dialog box, as shown in the following figure, choose the General option, then Existing 
Projects into Workspace, to import the project into the current workspace. 

 

Figure 97.   Project Import dialog with "Existing Projects into Workspace" option selected 
 

6. Click Next. 
7. To import the project, use either Select archive file or Select root directory. 
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a. Click Select root directory file as shown in the following figure. 

 

Figure 98.   Import Existing Project dialog 1 - Select root directory 
8. Click Browse. 
9. For Select root directory, browse to the project folder that you want to import. 
10. Select the file for import. 
11. Click Open. 
12. Select the project to import from the list of Projects, as shown in the following figure. 

 

 
 

Figure 99.   Import Existing Project dialog 2 
13. Click Finish to import the project. 
  



RZ/V2L, RZ/V2H, RZ/V2N Getting Started with Flexible Software Package 

R01AN6240EJ0400  Rev.4.00  Page 64 of 70 
Feb.13.26  

6. Multi-Core Debug 
In the case of RZ/V2H, FSP supports multi-core (CM33 core, CR8 core0, and CR8 core1) operation. 

This section describes how to debug a multi-core environment by running the Blinky project for each core. 

6.1 Project Creation for Each Core 
1. Create a workspace for each core. 

 

Figure 100.   Workspace creation 
 

2. Launch the e2 studio and specify workspace for CM33 core. 

 

Figure 101.   Launching the e2 studio for CM33 Core Workspace 
 

3. Generate a new project for the CM33 core in accordance with section 4.3. 
In the case of the CM33 core project, ensure to select Core and Project Template Selection as below. 

        
 

Figure 102.   Setting of the CM33 core project 
 

4. Build the Blinky project for the CM33 core.  
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5. Generate a new project for CR8 core0 in accordance with section 4.3. 
In the case of the CR8 core0 project, ensure to select Core, Preceding Project, and Project Template 
Selection as below. 

       

 

Figure 103.   Setting of CR8 core0 project 
 

6. Build the Blinky project for CR8 core0.  
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7. Generate a new project for CR8 core1 in accordance with section 4.3. 
In the case of the CR8 core1 project, ensure to select Core, Preceding Project, and Project Template 
Selection as below. 

       

  

Figure 104.   Setting of CR8 core1 project 
 

6. Build the Blinky project for CR8 core1.  
7. 3 projects are created in the CM33 core workspace. 

Copy all projects to the CR8 core0 workspace and the CR8 core1 workspace. 

 

Figure 105.   Copy the project 
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6.2 Debugging the Project for Each Core 
1. Select the Debug Configuration on the e2 studio of the CM33 core workspace and click Debug.  

 

Figure 106.   CM33 Core Debug Configuration 
 
2. Launch new e2 studio for CR8 core0 workspace.  

 

Figure 107.   Launching the e2 studio for CR8 Core0 Workspace 
 

3. Select the Debug Configuration on e2 studio of CR8 core0 workspace and click Debug. 

 

Figure 108.   CR8 Core0 Debug Configuration 
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4. Launch new e2 studio for CR8 core1 workspace.  

 

Figure 109.   Launching e2 studio for CR8 Core1 Workspace 
 

5. Select the Debug Configuration on e2 studio of CR8 core1 workspace and click Debug. 

 

Figure 110.   CR8 Core1 Debug Configuration 
 

6. You can debug each core project. 
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7. Appendix 
7.1 Known Issues 
7.1.1 J-Link DLL Version 
When RZ FSP V4.0.0 is installed, J-Link DLL version 8.60 is installed. This J-Link software is used when e² 
studio connects to the target board. However, if you are developing software using the CM33 cold boot mode 
of the RZ/V2H, you must use J-Link DLL version 7.96e, and therefore, you need to change the installed J-
Link software version. Here are the steps: 

1. Install J-Link 7.96e (following section: Download) 

2. Launch e2 studio, and select "Help" menu → "About e2 studio" → "Installation Details" 

3. Select the "Support Folders" tab. 

4. Click the link displayed to the right of "e2 studio support area." 

5. Edit DebugComp\RZ\ARM\rzv2h.4.0.0.xml as follows: 

Existing description: <Path>ARM/Segger_v8.60.0</Path> 

Updated description: 
* Replace C:\Program 
Files\SEGGER\JLink_V796e to the path J-Link 
7.96e is installed. 

<!-- 
<Path>ARM/Segger_v8.60.0</Path> 
→ 
<Path>C:\Program 
Files\SEGGER\JLink_V796e</Path> 

 

7.1.2 JTAG TRST Connection 
When the RZ/V2H AI MPU Evaluation Kit (RZ/V2H-EVK) or the RZ/V2N AI MPU Evaluation Kit (RZ/V2N-
EVK) is connected to the e2 Studio in JTAG I/F mode, it is necessary to modify the conversion adapter board 
provided by SEGGER. Specifically, the adapter board must be modified to connect the TRST signal between 
the J-Link and the target board. For details, please contact SEGGER. 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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